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This Step Is Critical!!!

PLEASE WAIT UNTIL ALL REPORT CARDS HAVE BEEN
PRINTED, VERIFIED, AND DISTRIBUTED FOR THE 2003-2004
SCHOOL YEAR BEFORE INSTALLING THE NEW VERSION OF
EASY GRADE PRO.

Disable any security software or log in to the highest level to complete the following:

Save and archive any existing grade books. Save them to a fileserver, CD or zip disk.

Delete all versions of Easy Grade Pro from your computer stations. Perform a FIND to insure
that all easy Grade Pro applications have been removed.

Empty the Trash.

Macintosh Stand-Alone Running System 7.0 – 9.2:
 Insert the new Easy Grade Pro CD (Dated May, 2004).
 Open the CD and double click on the installer. Navigate to the Applications folder on the

Hard Drive. Click the Install button and complete the Install procedure.
 Remove the CD.
 Open the Easy Grade Pro 3.6.2 folder. Open the Easy Grade Pro 3.6.2 application.
 Enter the serial number: 38-225-7362-35484121
 Enter the school name. Spell out Saint. Spell out School. Use capital and lower case

letters. This should be the same for all computers for a standard look on the report cards.

Macintosh Network (with Network Assistant) Running System 7.0 - 9.2:
 Insert the new Easy Grade Pro CD (Dated May, 2004).
 Open the CD and double click on the installer. Navigate to the Applications folder on the

Hard Drive. Click the Install button and complete the Install procedure.
 Remove the CD.
 Open the Easy Grade Pro 3.6.2 folder. Open the Easy Grade Pro 3.6.2 application.
 Enter the serial number: 38-225-7362-35484121
 Enter the school name. Spell out Saint. Spell out School. Use capital and lower case

letters. This should be the same for all computers for a standard look on the report cards.
 Copy the program to other computers on the network. (Use Network Assistant.)

Diocese of Cleveland – Release 2
Installation Instructions
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 Add an alias either in the Launcher or Apple Menu.
 Assign privileges to the program in the security software.

Macintosh OS X Running System 10.1 and above:
 Insert the new Easy Grade Pro CD (Dated May, 2004).
 Open the CD and double click on the installer. Click the Install button and complete the

Install procedure. The application will be found in the Applications folder.
 Remove the CD.
 Open the Easy Grade Pro 3.6.2 folder. Open the Easy Grade Pro 3.6.2 application.
 Enter the serial number: 38-225-7362-35484121
 Enter the school name. Spell out Saint. Spell out School. Use capital and lower case

letters. This should be the same for all computers for a standard look on the report cards.
 Quit the program and drag a copy of Easy Grade Pro to the Dock if desired.

Macintosh OS X Network (with Remote Access) Running System 10.1 and above:
 Insert the new Easy Grade Pro CD (Dated May, 2004).
 Open the CD and double click on the installer. Navigate to the Applications folder on the

Hard Drive. Click the Install button and complete the Install procedure.
 Remove the CD.
 Open the Easy Grade Pro 3.6.2 folder. Open the Easy Grade Pro 3.6.2 application.
 Enter the serial number: 38-225-7362-35484121
 Enter the school name. Spell out Saint. Spell out School. Use capital and lower case

letters. This should be the same for all computers for a standard look on the report cards.
 Copy the program to other computers on the network. (Use Remote Access.)
 Add an alias either in the Launcher or Apple Menu.
 Assign privileges to the program in the security software.
 Quit the program.

Windows Stand-Alone:
 Insert the new Easy Grade Pro CD (Dated May, 2004).
 Open the CD and left click on the installer. Complete the install procedure. Easy Grade

Pro will be added to Programs.
 Remove the CD.
 Open the Easy Grade Pro 3.6.2 application.
 Enter the serial number: 38-225-7362-35484121
 Enter the school name. Spell out Saint. Spell out School. Use capital and lower case

letters. This should be the same for all computers for a standard look on the report cards.
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Easy Grade Pro 3.6.2 for the Diocese of Cleveland contains two Diocesan-approved
grade scales.

The Diocesan Grade Scales are as follows:

A+ (100-98) C+ (84-82)
A (97-95) C (81-79)
A- (94-93) C- (78-77)
B+ (92-90) D+ (76-75)
B (89-87) D (74-72)
B- (86-85) D- (71-70)
F (69 and Below)*

O (100-93)
S+ (92-87)
S (86-79)
S- (78-77)
N (76-70)
U (69 and Below)*

Teachers have the option of using the tool palette and clicking on the appropriate grade
for each assignment/performance grade or typing in a percent/points within the grade
scale range.

If using the tool palette, be aware that the button for each grade will give the
average in that grade range. For example, clicking on S+ will give a 90%, the average
between the highest and lowest S+ range (87%-92%). This is important when considering
the range of an F grade or a U grade is between 69% and 0%. If using this feature of the
tool palette, it is recommended that a grade be typed for the F or U grade in the range
between 62 and 69% to provide an appropriate range in averaging total grades for the
term.

If typing grades manually, please use percent or points as determined for each assignment
or performance.

Diocese of Cleveland – Release 2
Diocesan Grade Scale Features
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Who should I contact with questions about how to manage the Diocese of Cleveland EGP
Project within my school building?

Speak with your building administrator to clarify procedures within your individual
buildings.

Who should I contact with questions about the Diocese of Cleveland EGP Project?
Visit the Diocese of Cleveland website with Easy Grade Pro Information:
http://www.dioceseofcleveland.org/education/oce/elementary/index.htm

For more information about the Easy Grade Pro Project please contact Mr. Andrew J.
Benton, Technology Utilization Manager/Webmaster at
abenton@dioceseofcleveland.org.

Who should I contact for support questions about using Easy Grade Pro?
The Office of Catholic Education has contracted with Basic Computer Learning to
provide ongoing support for schools in the Diocese of Cleveland for the 2004-2005
school year.

Gayle Blubaugh at gblubaugh@bclsite.com
Ann Marie Winchester at amwinchester@bclsite.com
Basic Computer Learning at www.bclsite.com

Diocese of Cleveland – Release 2
Support Resources
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1. The DOC Template is built into the Easy Grade Pro application program. There is no
Stationery Template to design each grade book. All grade books will begin by creating a
new grade book.

2. Grading scales will be in place as the school name is entered.

3. The grade book will look the same so navigating around will not be different.

4. Special features are built into the program to accommodate our Diocesan Report Card. As
new classes are entered, there will be a field called DOC CLASS NAME. If that field is
left blank, a warning message will appear. When prompted to enter that name, a pop-up
field will appear for the user to select.

5. New attendance categories are included to correspond more accurately with the tan roll
books.

6. Zeros will print for perfect attendance.

7. Teacher comments have been revised to produce a more meaningful report.

8. Users have the option of using one or two comments per class now. The code numbers on
the Report Card will be separated by a comma.

9. Primary reports have been expanded so the language arts area has separate spaces for
comments in each category.

10. Intermediate and Junior High reports have room for comments, conduct and effort in all
subject areas.

Diocese of Cleveland – Release 2
New Features - Introduction
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Begin each year’s grade book by creating a new grade
book file. That is, do not use a grade book from a
previous year and update it with new data. Using a file
for more than one year creates instability and
increases chances for a file to become corrupt.

Always store a grade book on a computer station hard drive. Back up to a server, floppy disk,
flash key or zip drive often.

• Launch Easy Grade Pro 3.6.2 Diocese of Cleveland Release 2.
• Create a New Grade Book.
• Give the grade book a name (blubaugh04-05.egp). Be sure you know where the

grade book is being saved.
• Add classes in order. Add only the classes you teach. This is a professional

document. Please spell out the full subject name using correct upper and lower case
letters. Indicate different sections by using room numbers, sections or grade levels.

• Designate one of the classes as the (HRM) class for recording attendance.
• Include the appropriate DOC Class Name from the new pull-down menu. Use the

(HRM) append only for the designated attendance class.
• Select all terms (quarters) that students receive a grade for that class.

Diocese of Cleveland – Release 2
Creating a New Grade Book
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Form A and Form C Report Card Set-up (suggested for grades 1-3):
1. Religion 10. Health
2. Reading 11. Physical Education
3. Phonics 12. Music
4. English 13. Art
5. Spelling 14. Computer Education
6. Penmanship 15. Foreign Language
7. Mathematics 16. Conduct
8. Social Studies 17. Effort
9. Science

Form B Report Card Set-up (suggested for grades 4-8):
List all classes and sections you teach. Do not include Conduct or Effort as a class.

Click Done when class listing is complete.

Setting Class Options:
• Navigate to your (HRM) class and set the class options.
• Remember that these options are class specific, so different options may be chosen for

different classes.
• Set the O-S-U grading scale, if needed.
• Set the Calendar for the First Quarter at this time in the designated (HRM) class.
• Navigate to the (HRM) class in each quarter and set the Calendar.
• Navigate to the Final (HRM) class and set the Calendar. Only the beginning date and the

ending date of school are needed here.

Copy desired Class Options to any other subjects and any other quarters.

View the Grade Book Options.
• Click the Display tab. Adjust the font and size to your comfort. The other items may also be

changed if desired.
• Click the General tab. See the

options. Set Compression to be
always ON.

• Click the Security tab. Set a Teacher
Password and verify it. Teachers may
import grades and classes, but not
open your entire grade book.

Import Student Names from a student
database file or a master Easy Grade Pro
Grade Book.

Always keep a copy of your grade book.
• A prompt will appear when quitting Easy Grade Pro. Choose to make a back-up copy of your

grade book.
• Put in a disk or navigate to where the back-up copy is to be stored.
• Delete the word “copy” from the file name. It may be helpful to add the date of the copy.
• Click Save. Remove the disk from the computer. Never use Easy Grade Pro with your

floppy disk in the computer.
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Easy Grade Pro 3.6.2 for the Diocese of Cleveland – Release 2 will track student absences
and tardies. Attendance for the Report Card should be kept in only one designated class of
each grade book. It is recommended that the first homeroom class be designated as the
assigned class for attendance. To navigate to that specific class for attendance, append the
letters (HRM) to
the class/Subject
Name. (HRM) is
s h o r t  f o r
homeroom. Check
off all quarters and
final. The pull-
down menu in the
custom data field
will allow the user
to match the
Class/Subject Name field.

Setting the School Calendar:

The school calendar must be set
to include the first day of the term
(quarter), the last day of the term
(quarter), and any no-school days.
This must be set in the (HRM)
class for each quarter. Set the
calendar in the final (HRM) class
to read the beginning and ending
dates for the current school year.
There is no need to reset any no-
school days in this Final calendar.
The calendar is found within the
Class Options dialogue box of the
Edit menu.

Diocese of Cleveland – Release 2
Recording Attendance
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Attendance is recorded on the Attendance Chart tab. Type the letters for each absence or
tardy or use the triangle to show or hide scores shortcut symbols:

Attendance codes follow the markings used in the tan attendance books:

Final attendance will be automatically calculated if:
• The Final (HRM) class has the calendar set for the first and last days of school.
• (HRM) classes for quarters 2, 3, and 4 have not been combined.
• Final (HRM) class has been combined with quarters 1, 2, 3 and 4.
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Adding a Grade for Conduct and Effort - Forms A & C
• Conduct and Effort grades are considered a separate subject in these forms.
• Use the Class Options from the Tool Menu to change the grade scale to O-S-U.
• Conduct and Effort may be recorded weekly as an assignment. Assignments may be

weekly social behavior and/or study habits. One suggestion is that these grades be
averaged just like other subjects instead of issuing just one grade at the end of the quarter.

• Click the triangle in front of the class name to see grades or open the Tool Palette. Click
the appropriate grade.

Adding a Grade for Conduct and Effort – Form B
Easy Grade Pro 3.6.2 for the Diocese of Cleveland Report Card feature provides space for Effort
and Conduct for each class subject. Teachers using Form B will assign student effort and conduct
within the custom label fields of the Student Records Dialogue Box.

• Effort and Conduct may be entered for each subject for each student.
• Click on the Student Tab of a desired class.
• Scroll to the right until the Effort and Conduct columns appear.
• Type the grade for each student in both of these classes. Grades are recorded O, S+, S, S-,

N, and U. Please use upper case letters.
• These values will need to be checked for each student each quarter. When student names

are copied to another quarter, the information in the student record moves with that
student.

Diocese of Cleveland – Release 2
Adding Effort, Conduct and Teacher Comments
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Adding Teacher Comments

• Pull the Chart menu down to Summaries or choose the chart icon on the tool bar.
• Select the Student Tab and the Comments Tab.

• The comments are pre-designed for uniformity and are pre-programmed to appear on all
Report Cards. Do not modify these twelve comments as they would then not match up to
the code key on the report card.

• Select the correct term, class and student.
• Click on a statement and it will appear in the Student Comments window.
• Click on a number in the student Comments window to delete it.
• Each student may have up to two comments per class.
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Grade book data must be complete for each subject, and additional class
grades need to be imported. The grade book must contain grades for all four
quarters to calculate a true final average unless the course is only two
quarters long.

• Navigate to the Final Classes and choose the first subject on the list.
• A message may appear to prompt the adding of student names. Choose to copy students

from the PRIOR TERM.
• Open the Class Options window from the Edit menu.
• Select the Term tab.

• Combine grades using weights to ensure that each term has a set value. Combining grades
using points is used when there is a direct continuation of the prior term. (Combining
grades using points cannot be used in any class using score category weighting.)

Diocese of Cleveland – Release 2
Combining Terms for Final Average
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• Match students by name. Matching by ID may be used if the grade book was originally set
up to include school IDs.

• Use the dark triangles to select the same class and combine terms with the fourth quarter,
third quarter, second quarter and first quarter. Be certain that the correct class is chosen. In
most cases, select Combine Term.

• Click Done.
• A message will appear that states that the student names matched. Follow the directions

given if student names are not identical. There should be a check in the box which states
“Automatically add current term grades column” and then click OK.

• Terms may be uncombined to print certain reports. Use the Class Option window and pull
each triangle to None in the dialogue box.

• Terms may be recombined if new data is entered. After the terms have been combined,
pull the Tool menu to Term Tools and choose Recombine terms.

• Final reports may then be printed.

• Final attendance will be automatically calculated if the final (HRM) class has set calendar
dates for the year.

• Conduct and Effort in the Form B Report Card do not average. This must be done
manually in the Student Records section.
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Combining Grade books allows student reports to be generated when homerooms are split
for other class/course offerings. Students can be tracked no matter how they appear in a
class list. One master homeroom class needs to be typed in even if the students are not in a
class together. This will help when printing report cards and tracking attendance. Perhaps
the student names can be entered in a class that does not receive a grade - like phonics for
the upper grades.

Note:  It would be easier to navigate within a combined grade book if the class names were
entered by homeroom (Religion Rm. 1), but this is not necessary for printing.

The combined grade book is used only to generate reports. Discard the combined grade
book when reports have been printed and verified.

A copy of each teacher’s completed grade book must be placed in a central location, such as in a
teacher shared folder on the server, or an EGP Report Folder on the hard drive of a central
computer. Then:

• Open the copy of one teacher’s grade book from that folder.
• Use the File Menu to Import. Select Combine Grade books and click Next.
• Locate the desired grade book to be combined.
• Select it and click Open. This will combine grade books.
• When prompted to import again, select “Yes” and repeat the process until there is one

grade book with all other grade books in it. Keep track carefully.
• Navigate to the class in which a report is desired.
• Then generate Progress Reports or Report Cards.

Diocese of Cleveland – Release 2
Combining Grade Books
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Enter all grades, Conduct, Effort, Attendance and Teacher Comments for each student for each
subject  in the current term period.

Combine Gradebooks within the Import Options to add other teachers’ Grades, Conduct, Effort,
Attendance and Teacher Comments for the subjects they teach.

All grades for the homeroom must be in the same grade
book.

Click on the Printer icon  or use the File Menu to select Print.
Select the Student Tab.
Choose the Diocese of Cleveland Report Card.
Type the Teacher Name.
Click Next.
This screen should appear:

Please see the next page.

Diocese of Cleveland – Release 2
Printing a DOC Report Card
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Create Report Cards for Students in: current class only.
Choose the Report of your choice:

Form A for self-contained classrooms  - multiple scales, one effort, one conduct
Form B for departmental classes - effort and conduct for each class
Form C for special needs - O-U scale, one effort, one conduct

Match students across classes by name. If your school uses IDs, you may decide to match by
ID instead.
Get Effort grade from Student Custom 1 (Effort).
Get Conduct grade from Student Custom 2 (Conduct).
Grade Label - Use Text - Type in the grade number only.
Teacher Name - Use Text - Type in Teacher Name.
Year Label - Type in the school year.
Principal - Type in the Principal’s name.

Always Preview your work. Scroll through the entire class to be sure all the data
is being transferred.

Print out a report.


